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INTRODUCTION  
Thank you for using the new and improved Just Checking. Are you tired of working math problems? Just 

Checking takes the pain out of balancing your checking accounts. The program is easy to use, but there are also 

powerful tools included. The program resembles a checkbook register. When you add income or an expense 

transaction, Just Checking automatically calculates the remaining balance. Reconciliation is a snap. Just set the 

Cleared date for a transaction and compare the Bank Totals with your bank statement.  

DEMO 
Before purchasing, it is recommended that you install and evaluate Just Checking as a demo. The demo can be 

downloaded from https://www.justapps.com. As a demo, there are some limits. First, only 20 transactions per 

file are permitted. Secondly, printing is disabled, but a print preview is available. Besides the demo limitations, 

the demo is identical to the registered version of the program.  

PURCHASING  
Purchase using Microsoft Store app in Windows 10  

If you have Windows 10, you can purchase Just Checking using the Microsoft Store app for $14.99. Currently, we 

do not have a trial version of Just Checking in the Windows 10 Microsoft Store app. The specific link to purchase 

is https://www.microsoft.com/store/apps/9NXNP4GXWMFM  If you purchase using the Microsoft Store app, the 

software and updates are automatically installed using the Microsoft Store app. NOTE: If you purchase using the 

Microsoft Store app and see a Demo notice, this is because the demo has been installed from our website: 

https://www.justapps.com. Refer to the BACKING UP & RESTORING topic in this document if you would like to 

preserve any data that you entered in the demo software. You can then uninstall the demo software in 

Windows in Control Panel at this location: Control Panel\Programs\Programs and Features 

 

Purchase from justapps.com 

If you do not have Windows 10 and want to purchase, you should use the following link to purchase using the 

Buy Now button at https://www.justapps.com/purchase-checkbook-software-windows.html 

If you do have Windows 10 but prefer to purchase using our website, the link will work for you too. After you 

purchase, a registration code will be sent to the email address provided during the payment process. Once you 

have been given a registration code, no refunds will be issued. Therefore, it is important that you install the 

demo and are satisfied that is will function to your satisfaction before registering. By purchasing you will be able 

to download the latest version of Just Checking at no cost. Once we receive an order notification that you have 

https://www.justapps.com/
https://www.microsoft.com/store/apps/9NXNP4GXWMFM
https://www.microsoft.com/store/apps/9NXNP4GXWMFM
https://www.justapps.com/
https://www.justapps.com/purchase-checkbook-software-windows.html
https://www.justapps.com/purchase-checkbook-software-windows.html
https://www.justapps.com/purchase-checkbook-software-windows.html
https://www.justapps.com/purchase-checkbook-software-windows.html
https://www.justapps.com/purchase-checkbook-software-windows.html
https://www.justapps.com/purchase-checkbook-software-windows.html
https://www.justapps.com/purchase-checkbook-software-windows.html
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bought the software, we will email the steps to have a fully functional Just Checking without the demo 

limitations.  

FEATURES  
• Database driven system allows you to manage all your checking accounts. Changes are automatically saved.  

This prevents you from losing your work if computer shuts down or locks up. All your data is stored on your 

computer.  

• Import transactions downloaded from your banking web sit. Support for Quicken® (qif, qfx, qbo) and 

Microsoft® Money (ofc) formats, Just Checking version 2 & 1 files (jck), File exported from version 3 (jc3), 

Open Financial Exchange (ofx), Comma Separated Value files (csv, txt).    

• Set up reoccurring transactions.  

• Set up users. Each user has their own files, reoccurring transactions, "auto lookup transactions", and 

password.  

• Income and expense reports. View income and expense for your open checkbook register file or all your files.  

• Powerful filter dialog permits you to filter out transactions by simple or complex criteria.  

• Sort transactions in the checkbook register with a single click. Click again to sort descending. Sort order is 

maintained when you add or edit transactions. Use the sort dialog to sort by multiple columns. You can sort 

each column differently, Ascending or Descending.  

• Specify different colors for income, expenses, and select. Fully customize the font name, size, color, etc.  

• Easily search the checkbook register for a specific word using Find. Non- matches are filtered out and matched 

characters are displayed in blue.  

• Edit any transaction in the checkbook register with a simple double-click.  

• Backup all your data to single compressed zip file. Restore also available.  

• Store addresses with your Memos and Payees.  

• Separate backup utility program included to backup and restore your database in the website version.  

• Date entry on dialogs is easy. Select your date from a calendar or use your arrow keys.  

• Transaction amount prefills from the last entered transaction when you select the Payee.  

• Easy lookup for Payees and Memos.  

• Specify your own Pay Types. You're not limited by the default list.  

• "Cleared" is a date for better checking account tracking. 

• Add a new transaction based on today's date or based on the date of the selected transaction.  

• Currency format is based on your Windows settings.  
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• Date format is based on your Windows settings.  

• Print more than one check at a time.  Also, printing a check is logged. You don’t have to print the same check 

twice unless you want to. Editing check layout is done visually with a visual check template editor. You can 

even import and export "check templates".  You can even pick your start check position. Add your signature to 

checks. Create a full check. Print the check number, account number, and routing number.  A MICR font is 

installed with the program.  

• Import and Export to a file (JC3) that you can use to move checkbook register files to another computer.  

• Settings dialog under Tools and you can also right-click a dialog to see your options.  

• Keep your software up to date easily. Just Checking has an option to check for updates on the Help menu.  If 

an update is available, the program will download and install the update for you. Non-Microsoft Store version. 

• Keep your software up to date easily. The Microsoft Store version of Just Checking is updated automatically 

just like other Microsoft Store apps. 

• Works on Windows 10, Windows 8, Windows Vista, Windows 7, and Windows XP  

• New Settings dialog to set color, columns, automatic backup, program prompts.  

• Use Settings dialog to hide and unhide columns and rearrange columns with your mouse (drag/drop).  

• Use the Tax checkbox to track specific transactions for tax time.  

• Income and Expense columns to make it easier to view your data.  

• Checkboxes to make it easier select transactions, checks to print, due items.  

• 32-bit and new 64-bit version.  

• Windows registry used to store program settings instead of an “ini” file for newer operating system 

compatibility.  

• Turn off sorting and use the Up and Down buttons to put transactions your preferred order  

• Support for QIF files from Quicken files in addition to the already supported QIF from online banking  

• New search dialog which filters out non-matching search terms and match text turns blue  

• Turn off sorting and use the Up and Down buttons to put transactions your preferred order  

• Using Ctrl + Page Up and Ctrl + Page Down will change Cleared date by one date on selected transaction  

• 3 Notes fields for transactions  

• Check number determined by the highest check number for the latest date instead of overall highest check 

number  

• Transaction dialog shows additional Payee and Memo fields  

• Edit user names once they have been set  
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• Hide and show columns in Settings  

• Split transactions  

• Specify categories and subcategories for transactions and split details  

• Category and Subcategory reports with multiple options. 

GETTING STARTED 
The first time you run Just Checking a dialog about registering will appear.  Close that dialog.  Click the New 

button to create a new file. Enter a Beginning balance of 500.00 and click OK. Then, click the Add button. Choose 

Expense and then enter the details and 100.00 for the amount. Leave the Cleared unchecked. Click OK. The new 

transaction will appear in the register. An Actual balance of 400.00 and a Bank Balance of 500.00 show at the 

bottom of the screen. Now click the Add button on the toolbar. The Add Transaction dialog appears.  Select 

Expense. Next, press Tab or Enter on your keyboard. Enter 100.00 in the Amount and check the Cleared field and 

click OK. The new transaction will appear in the register. Notice how the totals at the bottom of the screen 

reflect the new transaction. When you know a transaction has "Cleared" the bank, check the checkbox in 

Cleared and enter the date. You can also press F2 with the new transaction still selected in the main screen 

register when the transaction is selected to set the Cleared date to the present date. The Bank amount now 

reflects the transaction. You can also use Ctrl + Page Up to increase the Cleared date or Ctrl + Page Down to 

decrease the Cleared date.  

If you want to make a change to a transaction, double-click an entry in the register grid. An Edit Transaction 

dialog appears so you can make the change.  Click the OK button and you will see the changes in the register 

grid. If you change the Amount, you see the Actual amount change.  

Just Checking did the math for you!  

Saving Your Work & Reopening Your Checkbook Register File  

There is no need to worry about saving your work. Just Checking saves everything when you make changes. If 

you have more than one file and open the program, you will always be shown a Files dialog so you can choose 

the file you want to open. If you have one file, it will open automatically.  

Deleting Entries in the Register  

Occasionally, you might want to delete an entry from the checkbook register.  To delete an entry, highlight the 

item that you wish to delete in the register by single-clicking it in the grid.  Next, press the Delete key on your 

keyboard.  This is also covered in the Deleting Transactions topic.   

TOOLBAR COMMANDS  
The most common commands that you will use are readily available on the toolbar as buttons. 

New - Creates a new checkbook register file.  Create a different checkbook register file for each checking 

account that you have.  When you create new files, the files are assigned to the user you are logged in as. If you 
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create a file under a User named Bob, you cannot see the file when logged in under Mary. Select a File Name, 

Date and Beginning Balance for the file.  

 

Open - Opens a dialog displaying all the files for a specific user. Click a File to select it.  Click OK to open it.  

Reports - Displays a list of reports that you can run.    

Checks - This is the screen you can use print checks and design check templates.  

Add - Opens the Add Transaction dialog to you can input a new transaction.  The Adding Transaction topic 

further explains the command.  

Edit - Opens the Edit Transaction dialog so you can edit the selected transaction.  

Delete - Deletes the selected transaction from the checkbook register.  

Copy - Copies the selected transaction in the register as a new transaction.  The current date will appear in the 

new transaction.  If your Pay Type is a check number or a Void check, the new transaction will appear with a new 

check number.  The Cleared status of the new transaction depends on whether the selected transaction has 

Cleared.  You can also click Tools and choose Copy to activate the command.  

Find - Opens the Find dialog so you can locate a transaction in the register by a search value.  

Import - Opens the Import Wizard dialog.  Use it to import transaction from Quicken (QIF, QFX, QBO), Microsoft 

Money, Open Financial Exchange, the older Just Checking 1 & 2 (JCK) files, and the newer (JC3) format.  

Sort - Opens the Sort dialog so you can order your transaction by one or more columns.  Ascending and 

Descending sort order can be specified for each column.  

Filter - Opens the Filter Register dialog so you can create a filter.  Use this for the purpose of hiding transaction 

in the open checkbook register.  You will be prompted for a name for the filter after you specify the criteria.  

Reoccur - Opens a dialog so you can set up a list of reoccurring transactions for your checking account files.  

Calc - Opens the Windows calculator in case you need to make some additional calculations.  

Register - Opens a dialog to enter your name and registration code that you received in your email when you 

purchased the software.  After you have successfully entered the name and registration code, the Register 

button will be gone.  

Up - Moves a transaction up in the register. Turn off sorting to see this command. To turn off sorting, click Sort 

and then when the dialog opens, click a field in the Sort Order box and then click the button with the arrow 

pointing left. Remove all fields from Sort Order and click Ok.  

Down - Moves a transaction down in the register. Turn off sorting to see this command. To turn off sorting, click 

Sort and then when the dialog opens, click a field in the Sort Order box and then click the button with the arrow 

pointing left. Remove all fields from Sort Order and click Ok.  

 



 

7  

  

 

 

 

FILE DIALOG 

The File Dialog shows the beginning balance, file date and beginning balance for a specific file. To create a new 

file to see this dialog, click File and choose New or click the New button. You can also see this dialog when you 

use Edit on the Files dialog.  

 

 

 

FILES DIALOG  
The Files Dialog shows a list of accounts or checkbook registers that you have set up.  To access this screen, click 

File and choose Open or just click the Open button.  The screen also gives you the beginning balance and ending 

balance for each file and then totals them up.  You can use the screen to edit the file names, file dates and 

beginning balances.  You can also delete files here.  

  

  

ADDING TRANSACTIONS  
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Use the Add Transaction dialog to add transaction to your checking register file.  To add a transaction, press the 

Insert key on your keyboard, click the Add button on the toolbar, Right-click the register and choose Add, or 

click Tools on the menu bar and select Add...  

   

    
When the Add Transaction dialog appears, you can use Enter or Tab keys on your keyboard to tab through the 

data entry boxes.  

   

Income or Expense  

A transaction can either be income or an expense.  Click to select Income or Expense.  

Date  

Enter the date when the transaction occurred. The current date is automatically entered in the Date field, but 

you can change it if needed. Note: You can click Tools and choose Add Using Date if you want to create a new 

transaction using the same date as a selected transaction in your checkbook register.  

   

Pay Type  

Notice that Pay Type is only an option if you select Expense. There are 3 Pay Types when you install Just 

Checking 4.0 for the first time:  Check, Void, and Debit Card.  Leave Pay Type set to Check when you are 

writing a check for a purchase.  Void is usually used when you make a mistake when writing a check and need 

to log the check number used.  You can customize your Pay Types.  See the Pay Types topic for more 

information.  

   

Check No.  

Enter the check number in this field.  When you use the Add command to open the Add dialog, Just Checking 

searches the open checkbook register for the highest check number for the latest date.  Just Checking calculates 

the next highest value for you, but you can change it simply by typing over the value in Check No.  The Check No. 
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field is only available when you choose Check or Void as the Pay Type.  If you choose another Pay Type, a Check 

No. will still show but it will be gray and won’t be used.  

   

 

 

Payee  

When you enter an item that is an expense, this field holds the name of the person or company that you are 

writing the check to.  If your transaction is Income, you may want to type in the name of the income source.  

When you type a Payee that you haven't used before, Just Checking will give you the option of adding the Payee 

to a list so you won't have to retype the entire Payee again.  Also, use the Edit (F6) button to edit your entire 

Payee list from a separate dialog.  Hint:  Right-click the Add Transaction dialog and choose New Payee Prompt to 

uncheck the menu if you don't want to be prompted.  

   

Memo  

This field is used to describe the transaction.  For example, the Payee is Food Mart (a grocery store), so you 

might type Groceries for Memo.  If your transaction is Income, you may want to type in an extra description of 

your income.  When you type a Memo that you haven't used before, Just Checking will give you the option of 

adding the Memo to a list so you won't have to retype the entire Memo again.  Also, use the Edit  

(F7) button to edit your entire Memo list from a separate dialog.   

 

Hint:  Right-click the Add Transaction dialog and choose New Memo Prompt to uncheck the menu if you don't 

want to be prompted.    

  

Category  

This field is used to categorize the transaction.  

  

Subcategory  

This field is used to subcategorize the transaction.  

   

Notes  

These 3 fields give you a way to enter note information specific to the transaction you are entering.  

   

Amount  

The amount of the transaction goes here.  

   

Cleared  
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Use Cleared to set the clear date if the bank has processed the transaction. For example, if you have $100.00 in 

your checking account and purchase groceries for $50.00 and pay using a check, you still have $100.00 in your 

checking account until the check clears. Then your bank deducts the money from your account. The statement 

that you receive from your bank will show you a list of Cleared items. Most banks offer access your account 

online, so you can use the Internet to view your current account statement. To set the clear date, check the 

checkbox in the clear date box and then choose the date.  

   

Tax  

Use the Tax checkbox to mark a transaction as something you want to track for tax purposes. You can run 

income and expense reports and check the option to see only tax transaction totals.  

   

Tip: When you aren't using the Add Transaction dialog, you can also press F2 on your keyboard to assign today's 

date to the Cleared field of the selected transaction. You can also right-click the register and select Clear. Use 

the command again to delete the date from the Cleared field. Ctrl + Page Up and Ctrl + Page Down will change 

the Cleared date by one date on selected transaction.  

   

Repeat  

If you check the Repeat checkbox, the Add Transaction dialog will continue to reappear when you click OK.  Click 

Cancel to stop the dialog from continuing to appear. If you want to only add one transaction at a time, uncheck 

Repeat.  

EDITING TRANSACTIONS  
  

If you find a mistake in your register transaction, you can edit them.  To edit, Single click the transaction, right-

click, and choose Edit.  You can click Tools on the Toolbar and select Edit...  Another way to edit is by pressing 

Ctrl and E on your keyboard simultaneously.  Finally, the easiest way is to Double-click the transaction.  

   

The Edit Transaction dialog is nearly identical to the Add Transaction dialog.  

   

Tip: If you need to edit a transaction in the register to mark it cleared to today's date, there is no need to use the 

Edit command. Simply click the transaction in the checkbook register to select it and press F2 on your keyboard. 

Unclear by pressing F2 again. Ctrl + Page Up and Ctrl + Page Down will change the Cleared date by one date on 

selected transaction. 

DELETING TRANSACTIONS  
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Occasionally, you may need to delete a transaction from your checkbook register. First, single-click the 

transaction in the checkbook register to select it. There are four ways to delete a transaction. The easiest way is 

to press the Delete key on your keyboard.  You can also click the Delete button on the toolbar. You can right-

click the register and choose Delete. Finally, click Tools on the menu bar and select Delete...  

   

  

   

A dialog asking you if want to delete the transaction will appear. Click Yes to confirm the deletion.  

   

  

   

REOCURRING TRANSACTIONS  
  

To set up reoccurring transactions in Just Checking, click the Reoccur button on the toolbar. Another way is to or 

click Tools and select Reoccurring Transactions… or press F10 
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A dialog will appear showing all your existing reoccurring transactions. Click the plus sign button to add a new 

one. Another dialog will appear. It is similar in appearance to the Add Transaction dialog. There are also 

command buttons to Edit and Delete the reoccurring transactions from the list.  

 

  

   

In the Next Date field, pick the date when the transaction occurs again. Select whether the transaction is an 

Expense or Income. Pick the way the transaction is paid for under Pay Type.  In the Repeat combo, select how 

often the transaction occurs. If you want to set the reoccurring transaction to show up for you to pick before the 

actual Next Date mentioned earlier, enter the days in Days Before. The File combo shows all the checkbook 

register files.  Pick the correct file for the reoccurring transaction. Enter the Payee. Enter the Memo. Finally, 

enter the Amount and click OK.  

   

While Just Checking is open, the program will periodically check for reoccurring transactions for the checkbook 

register file you have open.    

   

If there is a reoccurring transaction due, a Due Transactions in File dialog will appear. To add the transaction 

or transactions to your open file, you will need to make Select is checked. To select, click each Select 

checkbox. You can also hold Ctrl on your keyboard and click each transaction. Click OK. Transactions that are 

added, are marked as “Tagged”. This just means they are displayed in a different color if the “Tag” color is set 

differently. This helps to see the transactions that were added. You can press F3 to toggle a transaction as 

“Tagged” or “Untagged”. To “Untag” all transactions, click Tools and choose “Untag All”.  

 

If you decide to not add the reoccurring transaction to your register when the “Due Transactions” appears, 

you can add it later. Just right-click the register and choose Due Transactions. Then, click Reviewed. Use 

the same method to “Select”.  Finally, click OK.    
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NOTE: If you want to remove the due transaction from showing later, click “Select” to check it, then right-click 

the list of transactions in the “Due Transaction” dialog to get the option to “Delete Selected” due transactions.  

   

  

   

MANAGING PAY TYPES  
You can access the dialog to edit your Pay Types different ways. One way is to right-click the checkbook register 

on the main screen and then left-click the “Pay Types” menu. Another way is to use the Edit (F5) button on the 

Transaction dialog.  When you first install Just Checking, you have two Pay Types:  Check and Void.  It is not 

possible to delete these two Pay Types. The "Void" Pay Type doesn't affect your balance. Use it when mistakes 

are made or when you need to hand over voided check to set up auto bank draft at a business. Check the 

“Default” checkbox for a Pay Type if you want it to be the default Pay Type when entering a new Expense 

transaction.  
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MANAGING PAYEES  
  

You can edit your Payees different ways. One way is to right-click the checkbook register and then left-click the 

“Payees” menu. Another way is to use the Edit (F6) button the Transaction dialog. The Payees dialog shows a list 

of all your saved Payees. Each Payee has 3 additional fields called Payee 2, Payee 3, and Payee 4. These are 

mainly used for specifying an address to that Payee. These can be added to check templates for printing checks.  

   

  

  

 

MANAGING MEMOS  
  

You can edit your Memos different ways. One way is to right-click the checkbook register and then left-click the 

“Memos” menu. Another way is to use the Edit (F7) button the Transaction dialog. The Memos dialog shows a 

list of all your saved Memos.  Each memo has 3 additional fields called Description 1, Description 2, and 

Description 3.  These are mainly used for specifying an address to that Memo. These can be added to check 

templates for printing checks.  
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MANAGING CATEGORIES & SUBCATEGORIES  
You can edit your Categories & Subcategories using the Edit button beside the corresponding box on the 

transaction, reoccurring, and split dialogs.  

BALANCES 
 

Beginning  

When you create a file, you can specify the Beginning Balance of the checking account. This amount is used to 

calculate your other balances and is always displayed. To change it, click Open and then click Edit. Then change 

the Begin Balance.  

Balance column 

The Balance column represents the balance activity in your account even for transactions that have not cleared 

the bank, so the Balance amount shows for each transaction in the check register. The calculation starts off with 

the Beginning balance. Then, a calculation is made for each transaction in the check register. The order in which 

the calculation occurs depends on Tools, Settings, Other, Calculate Balance Totals. The default order is from top 

transaction in the check register to the bottom transaction in the check register. 

Bank column 

The Balance column represents the balance activity in your account for transactions that have cleared the bank. 

The calculation starts off with the Beginning balance. The calculation starts off with the Beginning balance. Then, 

a calculation is made for transaction that are marked with a Cleared date. The order in which the calculation 

occurs depends on Tools, Settings, Other, Calculate Bank Totals. The default order is from top transaction in the 

check register to the bottom transaction in the check register. 
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Below the register you will see a bar divided into 3 sections.  These sections show totals that will help you keep 

up with your checking account balance and reconcile your account. The first is Balance which was explained 

above.  

 

Actual  

Actual is the difference between all your income and expense transactions including transactions that have yet 

to clear the bank.  

 

Bank  

Bank is the difference between all your cleared income and cleared expense transactions. You should set the 

Cleared field, when a transaction has cleared the bank. This number represents the amount that your bank 

should show in the account. You can press F2 to toggle a transaction to cleared (uses today's date) or to 

uncleared.  

  

  

PRINTING REPORTS  
To print reports in Just Checking, click the Print Reports button or click File and choose Print Reports. The Report 

Wizard dialog will appear. There are various reports available in Just Checking. You can print the category, 

checkbook register, memo, payee, subcategory reports. When you click a report and click Next, there are 

options to filter the results. Depending on the report, there are options for date, file, payee, cleared, tax, 

income/expense, totals/summary/detail.  
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PRINTING CHECKS  
To print checks in Just Checking, click the "Check" button or click File and choose Print Checks. A dialog appears 

listing the transactions that are checks. Simply click the checkbox in the Select column for each of the checks 

that you want to print. 

 

  

   

After all the needed checks are selected, click the Preview button.  A print preview will appear with the checks in 

order by their check number.  Now just click the print button to print.  
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CHECK TEMPLATE EDITOR  
  

The editor allows you to make changes to your check templates and has many commands.  To access 

the editor, click Checks.  From the Print Checks dialog, either click Edit or use New, double-click a 

template, and enter a check template name.  

 

  

• Cut removes the selected elements and puts them on the clipboard  

• Copy copies the selected elements and puts them on the clipboard  

• Paste puts the elements that were on the clipboard onto the selected band  

• Undo removes the last change made  

• Back puts the selected elements behind the layer they are on  

• Front puts the selected elements in front of the layer they are on  

   

  

• Select sets your mouse pointer to select mode so you can click an element to select it  

• Band sets your mouse pointer to create a new band  

• Label sets your mouse pointer to create a new static label element  

• Data sets your mouse pointer to create a data field element.  

• Memo sets your mouse pointer to create a new memo element  
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• Image sets your mouse pointer to create a new image element  

• Shape sets your mouse pointer to create a new shape element  

• Zoom In increases the zoom level in the designer  

• Zoom Out decreases the zoom level in the designer  

• View opens a dialog that lets you make changes to the designer.  You can enable a ruler, change the 

unit of measurement, enable/disable band names, grid point density, etc.  

• Report opens a dialog to set the paper size, margins, columns and spacing (for labels), orientation, etc.  

• Database lets you configure the data for the open report template  

   

Report Template Editor Tips:  

• To move an element in the designer, make sure you are in Select mode by clicking the Select button. 

Then, click the element. You will see that the element has the focus because there will be small 

blocks around the element. Now you can use your arrow keys to move the element. You can also use 

your mouse to drag an element, but arrows work best to make small adjustments.  

• To save changes, close the designer using the close X in the upper right corner of the window. When 

you get the prompt to save, choose Yes. 
• The templates are made up of the representation of paper size of your check paper, the band 

represents one check, and the elements represent static text (label) and data that comes from the 

transactions that you entered in the register. 

COLOR & FONT  
If you want to change the color and font, just right-click the checkbook on the main screen. A popup 

menu will appear with the options. You can also click the Tools menu at the top of the main screen to 

access the Font and Color commands. 

 

You will see a menu item for Font. The sub menus under Font allows you to configure the font for the 

checkbook register and the checkbook register column titles. The font dialog gives you options to 

change font name, size, and attributes such as underline, bold, and italic. 

   

You will also see a menu item for Color. There is a sub menu to change the "Selected Row Color" 

which is the color of the selected transaction. There are sub menus to change the "Income Text Color" 

and "Expense Text Color".  There is a sub menu to change the "Negative Balance Text Color" which is 

the color of amounts less than zero in the Balance column. There is a sub menu to change the "Tag 

Color".  There is a sub menu to change the "Alternating Row Color" which is the color of alternating 

transactions in the register for readability. Use "Grid Background Color" to change the color of 

transactions between the alternating rows.  Finally, use "Uncleared Row Color" to set the color for 

transactions that have not yet cleared.  
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Alternatively, click Tools, click Settings, to set colors.  

   

SORT DIALOG  
You may want to keep transactions in your checkbook register automatically sorted by one or more 

columns. For example, you may want to keep transactions in order by Date first and then Amount next. 

Use the Sort command to accomplish this. To open the Sort dialog, click the Sort button on the toolbar. 

The Sort... command is also on the Tools menu. To access it with your keyboard, press Ctrl and S on your 

keyboard at the same time. 

  

  

   

On the Sort dialog, fields moved to the “Sort Order” side determines the sorting order for the checkbook 

register. You can double-click an “Available Field” or use the right arrow button to move one of the 

“Available Fields” to the “Sort Order” list. Before moving a field, click either Ascending or Descending. 

Ascending is sorting from the least to the greatest. Descending is sorting from the greatest to the least. 

If you want to move a field back to the Available Fields, click the left arrow button or double-click the 

field in the Sort Order List. The Up and Down buttons allow you to reorder the Sort Order fields. You can 

also click a Sort Order item and hold while moving the mouse up or down to rearrange the Sort Order 

item order. When you click OK, the sort order can still be seen by noting the indicators in the checkbook 
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register column headings. The up arrow indicator represents an Ascending sort and the down arrow 

indicator indicates a Descending sort. 

 

 

 

If you enable the “Allow Title button click to set Sort” under Tools, Settings, Other you can then click a 

column heading in the register to sort by one column. Click the same column again to sort in the 

opposite direction.  

   

If you want to disable sorting, click the Sort button and remove all fields in the “Sort Order” column. By 

removing all fields, transactions will appear in the order that you entered them. When there are no sort 

fields, you can use the “Move Up” “Move Down” buttons on the toolbar to move the selected 

transaction up or down in the register. The “Move Transaction Up” or “Move Transaction Down” 

commands can be accessed by using right-clicking on the register.  The keyboard shortcuts for these 

commands are Ctrl + U and Ctrl + D. 

 

  

FILTERING  
A filter is criteria used to see certain transactions which in turn hides the other transactions. To create a 

filter and set it active, click the Filter command.  

 

 

The Filter Register dialog will appear. Use it to set the criteria for the transactions that you want to see.  

The rest of the transactions will be hidden until you cancel it.    

  

   

After you set the criteria, click OK and then specify a name for the filter.    
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The status bar at the bottom of the screen shows a filter area.  When a filter is active, it will show "Filter 

is January 2019" for example.  When there is no filter active, it will show "No Filter".    

  

 

The Filter button is also red when a filter is active. 

 

  

If you want to turn off the filter, click the “File” menu and choose “Cancel Active Filter”. Once you create 

a filter, you can use it again even after you have used the “Cancel Active Filter” option. To reuse a filter, 

click the “File” menu and choose “Load/Delete Active Filter”. A dialog appears. Click the filter you want 

to reuse and click OK. If you want to get rid of a filter that you don't want, click a filter in the list and 

press Delete on your keyboard. If you close Just Checking while you have a filter active, the filter will still 

be active when you open Just Checking later.  Additionally, an active filter will stay active even when 

switch to another file in your database. 

 

   

By default, when you use Filter, the running balance remains as if you had not filtered.  This also holds 

true for the totals at the bottom of the screen. If you want the balances to calculate as if hidden 

transactions did not exist, click Tools, Settings, Other, and then check “Only calculate Balances for 

Unhidden Transactions when Filtered”. 

   

Filter is powerful. For example, you could set a Filter to only show only transactions that occurred in 

January 2019 with a Pay Type of Check and a Payee of Walmart. To do this, you would click Filter. Then, 

click Date under Fields. Type 01/01/2019 (This is assuming you have a US Date Format) in Starting 
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Range.  Type 01/31/2019 in Ending Range. Click the Pay Type under Fields and type Check in the Field 

Value. Click the Payee under Fields and type Walmart in the Field Value. Click OK. Then type a name for 

the Filter and click OK. It is important to note that new or edited transactions that don’t meet the 

criteria will be hidden. 

  

Filter Tip 

If you want to see only transactions that have yet to clear the bank, click the "Cleared Date" in the Fields 

list and then click "By Value". Next, type null in the "Field Value" box and click OK. 

IMPORT WIZARD  
The Import Wizard allows you to import transactions from Quicken (QIF, QFX, QBO), Microsoft Money 

(OFC), Open Financial Exchange (OFX), Just Checking 2.x & 1.x (JCK), and Just Checking 3.x and 4.x 

Exports (JC3), Comma Separated Values (CSV) and Text (TXT) files. To open the Import Wizard, click the 

Import button on the toolbar. Alternatively, press F5 or click Tools and choose Import Wizard. 

  

 

When the Import Wizard dialog appears, click the Browse button to choose the file to import. Make sure 

you choose the right file type in the “Files of type” box on the open dialog.  Click Open.   
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Back on the Import dialog click Next.  The next screen shows all the transactions in the file.  All 

transactions have “Select” checked to begin with.  You can click the “Select” checkbox to check or 

uncheck.  You can also press the Ctrl key and click each item that you wish to select or unselect.  When 

you click Finish, all transaction that have “Select” checked are added to your checkbook register file.  A 

progress dialog will appear during the import to give you an idea of time involved.  Importing a large file 

may take several seconds or even minutes.  

  

   

 

Tag and Untag 

After you import transactions, you will notice that the transactions appear with a different color (default 

is Money Green). This means the transactions are set to “Tag”. “Tag” allows you to tell which 

transactions were imported. To "Untag", click a transaction to select it and press F3. If you were to press 

F3 again, the transaction will be set to “Tag”. If you want to “Untag All” transactions, click Tools and 

choose “Untag All”. As an alternative to using a “Tag” color, you can use a “Tag” checkbox column. To do 

this, go into the Settings dialog. Check the Tag option in Column Visible/Order page. In the Color page, 

set the "Select" color to White.   
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Formatting CSV for Import 

To avoid issues with importing csv files, make sure your csv files are like the csv file that results from 

exporting your file to a csv using File, Export and choose “Comma Delimited File (*.csv)” in the “Files of 

type” box. You can open this file with Excel or Notepad to view the format. 

BACKING UP & RESTORING  
If your system crashes because of hardware failure, you may lose all the programs on your hard drive. 

You can always get your system fixed and reload Just Checking, but unless you have a backup copy of 

your data you will not be able to recover the information that you entered. The Backup Database 

command can save you a lot of work!    

 

Backing Up  

The Backup Database saves all your work. This includes your entire database: Users,  

Files, Pay Types, Payees, Memos, Reoccurring Items, everything!  When you use Backup Database, you 

will see a "Backup Just Checking Data to File" dialog.  The program conveniently offers a file name for 

the backup.  The file name is made up of the exact date and time the backup was made.  The format is 

JustChecking + YEAR + MONTH + DAY + 1.ZIP.  It is recommended that you save the file to some sort of 

storage media other than your hard drive such as a flash drive. If the data is important to you, put the 

storage media in a fire proof safe for safekeeping. To backup, simultaneously press Ctrl and B on your 

keyboard. You can also just click File and choose Backup Database... You can even set Just Checking to 

back up every time the program closes. To do that, click Tools, Settings, Backup, and check the 

"Automatically Backup on Program Close". The program will back up to the location that you specified 

when you last used File, Backup Database  

   

Restoring  

If you want to move your checkbook register files from one computer to another computer but retain all 

the information on both computers, use the Export option and save your files to JC3 files. See the Export 

topic for more information. The Restore Database command replaces the database that Just Checking is 

currently using with a backup copy. Be sure to use the Backup Database command before you use 

Restore Database if the data you currently see is important. When you use Restore Database, you will 

first receive a warning that your database will be overwritten with a backup database. Click Yes if you 

wish to continue. Next, locate the ZIP file on the media that you used when you initially made the 

backup. After you select the file and click Open, Just Checking will finish restoring the database.  

   

Just Checking “Desktop Version” Tip:  You can use the “Data Utility” program to back up and restore. To 

access it, click the Windows start button, choose All Programs, find the Just Checking folder and choose 

Data Utility. The Data Utility supports restoring from files Backed Up with older versions of Just Checking 

that used the .001 format. 
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PASSWORD  
Use Tools and pick Password to set or change a user password.  Initially Just Checking has one user 

called "Default" with no password assigned, but you can change the User too.    

   

 

Once you set a password, you will receive a "Just Checking User Login" dialog when starting Just 

Checking.    

  

   

You can click the button to create a new user from this dialog too. If you create a new user and are 

presented with a dialog about being unregistered, click Help and choose Register while logged in under 

the new user. You can use the same Name and Registration Code as before. Your files are assigned to 

users, so if you have two files under the same user you will use the same password to open the 

program. 

EXPORTING  
Use the Export command permits you to save the contents of the checkbook register grid to a JC3 

file or a CSV file.   

   

JC3  

A JC3 file is text file delimited by a special character.  JC3 files can be imported into Just Checking 4.0 

using the Import Wizard. JC3 files are useful for transferring a specific file to another computer. If you 

want to transfer your entire database, use the Backup and Restore commands.  
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CSV  

A CSV file is text file delimited by a comma. The file will open with spreadsheet programs such as 

Microsoft Excel.  The CSV file that results is the same that the program expects when you use the Import 

function to import a CSV file. 

   

JCK (Just Checking for Mac)  

This exports your transactions to a file that is compatible with Just Checking for Mac.   

QUESTIONS & ANSWERS  
  

Q.  How can I set a password?  

A.  Click the Tools menu at the top of Just Checking and choose Password.  Type a password twice in 

the boxes provided. You can also change the Default user there. The next time you start Just 

Checking, you will see a logon dialog. Select your User name from the User list and type your 

password.  

   

Q.  Where do I get a MICR font for the Account Number and Routing Number information?  

A.  The program installs a MICR font and it is called gnuMICR.    

   

Q.  I've got the font installed now what?  

A.  Click Print Checks on the main screen, pick a template in "Selected Template" and click Edit.  When 

the editor appears, you'll see the routing/account number area field using the special MICR font.  

Next, right-click it and choose Edit.  Type your Account No and Routing Number in the Expression 

(The special symbols are letters A, B, C, D and when you finish it should look sort of like this:    

  

    'A12345678A   123456789C   ' + Data.CheckNo   

  

Notice that we added some spaces in there.  Make sure you have the two single quotes in there. Click 

OK. To make it show up when you print, you need to Enable it.  Right click the MICR field and choose 

"Enabled" to enable it for printing.  Below we see what the font looks like when we view it in the print 

preview.  
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Q.  How do I add a signature to my checks?  

A.  To add your signature, you need to scan a signature and crop out the extra white space. Your image 

should be in a rectangle image shape like the sample image below. Save it as a JPG, PNG or BMP.  

When in Just Checking, click Print Checks and click Edit. Tab to the empty rectangle in the lower right. 

Once it has the focus, double-click it to pick your signature file.  Note that we checked the stretch 

checkbox to make it scale our image to fit.  

Example signature:  

  

  

  

 

  

 

Q.  I used Just Checking 2 prior to this Just Checking 4.0.  How do I import my old information?  

A.  Use the Import Wizard. Once the Import Wizard is open, click Browse. Choose "Just Checking Files 

(*.jck)" in the Files of Type box. Then in the "Look In" box change to "Program Files". Next, double-

click the JCheck folder.  You should see your JCK files there.  Open one and click Next. Click Finish to 

import the selected transaction.  Imported transactions will be selected (in green by default). This 

gives you a visual way to see what was imported.  Highlight a transaction and press F3 to unselect.  
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Q.  I don't want the "Date" box to have to be the first entry box when I add a transaction.  Can I 

change it to something else?  

A.  If you want to cursor to be in another box such as Payee when the transaction dialog open, you can 

change it.  Right-click the Transaction dialog. A popup menu will appear. You will notice that Date has 

a bullet beside it, just left click another field such as Payee. Now Payee will have the focus when 

opening the transaction dialog.  

   

Q.  I don't want to see a prompt when I add a new Payee or Memo while in the transaction dialog.  

How do I turn it off?  

A.  Right-click the transaction dialog. A popup menu will appear. Left click New Payee Prompt. This will 

uncheck it.  You can do the same with the New Memo Prompt. If you ever want to turn the prompts 

back on, just left click to check them. 

   

Q.  I noticed that there was a new version on your site.  How come I wasn't notified?  

A.  There are several customers and email addresses change so often it is hard to keep up with all of 

them. We have a better solution built in. Open Just Checking and click the Help menu (beside of File 

Tools) and choose "Check for Update". A wizard dialog will appear and check for the update. If one is 

available, the wizard will download, close Just Checking, and install the new version for you. If it 

doesn't install the update, just close Just Checking and go to our web site at 

https://www.justapps.com or email us at help@justapps.com if you need a new registration code. Be 

sure to include your name and any other information from your original purchase that would help us 

locate you. Note that if you purchased and installed using the Microsoft Store app, the updates are 

installed automatically. 

Q.  I live in the USA.  I don't like negative numbers to appear with parenthesis.  How can change it so I 

see a minus sign instead?  

A.  We like the minus sign better too.  The program gets all currency and date settings from your 

system.  You can change this in Control Panel.  Open Control Panel.  Switch to Classic if you do not 

see a "Regional and Language Options" icon.  Double-click "Regional and Language Options".  Click 

"Customize" or "Additional Settings" and click the "Currency" tab.  Choose $-1.1 for "Negative 

currency format".  

Q.  The check template that I use doesn't print on checks in the position I want it to.  Can I make a 

change?  

A.  You certainly can.  Click Checks.  Click Edit. The "Check Template Editor" should appear. Click a field 

that needs to be moved. This will select it. Use your arrow keys to move the field left, right, up, or 

down. If you want to change the font, you can do that too when the field is selected.  When you 

close the "Check Template Editor", you should see a dialog that says "Save Changes?". Choose Yes.  

   

 

https://www.justapps.com/
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Q.  I get an error when I try to import my old .jck file.  It says something like '22/08/2005' is not a valid 

date?  

A.  First try changing the Date Format option in the Import Wizard.  If that doesn't work, you can try 

changing the windows setting.  Go into Control Panel and then into the Regional and Language 

Options.  Click the Customize button and then click the Date tab.  Change your "Short date format" to 

dd/mm/yyyy.  Click Ok.  You will need to restart Just Checking for the change to take effect.  

 

Q.  The 2.XX version shows the date with leading zeros.  For example:  01/01/2006.  Is there 

a way to do this in 4.0?  

A.  The currency format and the date format are determined by Windows.  It is programmed so the 

program would work for users in other countries.  You can fix this easily.  Just open Control Panel in 

Windows and then open "Regional and Language Options".  Click Customize.  Click the Date tab.  Just 

change the Short date format to MM/dd/yyyy.  This will make the leading zeros appear.  

   

Q.  Can I store my data on another drive or folder than where my program files reside?  

A.  The normal location for the program data folder is "C:\JustChecking" and the normal location for the 

data is "C:\ JustChecking\Data". In order to move the data, you will need to copy the data folder to 

the new location using File Explorer. Then you need to edit your shortcut. Right-click your Just 

Checking desktop icon and choose Properties. After the existing target add a space and then type 

your new location.  For example, the new target will be something like this:  

   

c:\justchecking\justchecking.exe f:\justchecking\data  

   

Q.  Any way to run multiple copies of Just Checking with each one pointing to different databases?  

A.  Create at least two shortcuts on your desktop for Just Checking. Right-click the shortcut and choose 

Properties.  In the Target specify the data folder after the application file path. Example:  

   

c:\justchecking\justchecking.exe f:\justchecking\data  

   

Do this for each icon.  

   

Q.  I'm receiving a database error 8961.  How can I run a repair if I can't get into the program?  

A.  Close the error. If you cannot exit the program, press Ctrl + Alt + Del on your keyboard and open Task 

Manager.  End Task for Just Checking.  Next, click the Windows start menu and choose All Programs.  

Then find your Just Checking folder and look for the Data Utility and click it.  When the utility 

appears, click the Repair Data button. That should fix the issue. Just try using Just Checking again.  
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Q.  I purchased the software using the Microsoft Store app in Windows 10. Why am I seeing a demo 

notice box when the program opens. 

A.  We do not have a demo version in the Microsoft Store app, so you are using a version of Just 

Checking that you downloaded from https://www.justapps.com You should uninstall that version and 

use the Just Checking icon to start the program. If you want to preserve any data from the 

justapps.com version using the steps from the BACKING UP & RESTORING topic. You can uninstall 

from Control Panel in Windows at this location: Control Panel\Programs\Programs and Features 

• Just Checking (Windows 10 Microsoft Store version icon)  

• Just Checking (justapps.com downloaded version icon)  

Q.  How can I try the software before purchasing?  

A.  Go to https://www.justapps.com, click Just Checking for Windows, click Download, click 

justchecking64_setup.exe or justchecking_setup.exe You may have to double-click the downloaded 

file to run the installer. 

Q.  What is the refund policy?  

A.  We suggest that you download and install Just Checking from https://www.justapps.com to evaluate 

the software in demo mode before purchasing. The demo version is the same as the full version 

besides printing limitation. If you have already purchased using the Microsoft Store app in Windows 

10, you will need to request a refund using the Microsoft Store app. We have no control over 

Microsoft Store app refunds or Microsoft’s refund policy. If you purchase using the Buy Now option 

on our website and we have sent out a registration code, we do not offer a refund because the demo 

is available to download and evaluate. The page with the Buy Now button has a Note specifically 

mentioning this. 

SUPPORT  
If you are experiencing a problem or having trouble finding an answer in this help file, you may email us.  

email:  help@justapps.com  

website:  https://www.justapps.com  

 

We make additional programs that you may find beneficial.  Visit our website for more information. 
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